Appendix 9 — Word 365 options

Introduction

When | want to change one of the options, | can never find it in all the various menus and submenus! So | have typed
out all the options, so that they are searchable. Then if | want to change, say, automatic smart quotes, | just search for
‘smart’ and find that it’s not in the main options, but in one of the sections within Proofing—AutoCorrect options.

(N.B. I’ve highlighted the 2010 options — in the following appendix — in grey so that if you’re searching for a
particular option and you get to a grey highlighted area, you’ll know that this is relevant only to Word 2010, and not
365.)

General
General options for working with Word

User Interface options
When using multiple displays:
optimize for best appearance
optimize for compatibility (application restart required)
Show Mini Toolbar on selection
Enable Live Preview
Update document content while dragging
Collapse the ribbon automatically
Collapse the Microsoft search box by default
ScreenTip style: [menu]

Personalize your copy of Microsoft Office
User name: [input]

Initials: [input]

Always use these values regardless of sign into Office
Office Background [menu]

Office Theme [menu]

Privacy settings
Privacy settings [menu]

LinkedIn features

Use LinkedIn features in Office to stay connected with your professional network and keep up to date in your industry
Enable LinkedIn features in my Office applications

About LinkedlIn features Managed LinkedIn account associations

Start up options

Choose the extensions you want Word to open by default: [Default Programs...]

Tell me if Microsoft Word isn’t the default program for viewing and editing documents.
Open e-mail attachments and other uneditable files in reading view

Show the Start screen when this application starts

Co-authoring options
Allow co-authoring on files with macros

Real-time collaboration options
Show names on presence flags



Word Options

i General

Display

Proofing

Save

Language

Ease of Access
Advanced
Customize Ribbon
Quick Access Toolbar
Add-ins

Trust Center

E‘Q General options for working with Waord.

User Interface options

When using multiple displays: G

® Optimize for best appearance

Optimize for compatibility (application restart required)

1 Show Mini Toolbar on selection G
[ Enable Live Preview G
Update document content while dragging &
[ Collapse the ribbon automatically G
[] Collapse the Microsoft Search box by default G

ScreenTip style: | Show feature descriptions in ScreenTips 57
Personalize your copy of Microsoft Office

User name: Paul Beverley

Initials: PB

[] Always use these values regardless of sign in to Office,
Office Background: | No Background =

Office Theme: Colorful -

Privacy Settings

Privacy Settings...

LinkedIn Features
Use Linkedln features in Office to stay connected with your prefessional network and keep up to
date in your industry.
Enable LinkedIn features in my Office applications (&

About LinkedIn Features Manage Linkedln account associations

Start up options

Choose the extensions you want Weord to open by default: | Default Programs...

[] Tell me if Microsoft Word isn't the default program for viewing and editing documents.
[] Open e-mail attachments and other uneditable files in reading view G

[ Show the Start screen when this application starts
Co-authoring options

Allow co-authering on files with macros
Real-time collaboration options

[J Show names on presence flags

OK I | Cancel

Display

Change how document content is displayed on the screen and when printed.

Page display options

Show white space between pages in Print Layout view
Show highlighter marks

Show document tooltips on hover

Always show these formatting marks on the screen

Tab characters
Spaces

Paragraph marks

Hidden text

Optional hyphens
Object anchors




Show all formatting marks

Printing options

Print drawings created in Word
Print background colors and images
Print document properties

Print hidden text

Update fields before printing
Update linked data before printing

Word Options ? Y
General o— - . -
................................................................. :O\ Change how document content is displayed on the screen and when printed.
. Display
Proofing Page display options
Save [] Show white space between pages in Print Layout view G
Language Show highlighter marks &

. Show document tooltips on hover
Ease of Access

Advanced Always show these formatting marks on the screen
Customize Ribbon [ Tab characters —
CQuick Access Toolbar [ spaces
) O Paragraph marks T
Add-ins .
[ Hidden text abc
Trust Center [] Optional hyphens -
Object anghors '\T;

[ Show all formatting marks
Printing options

Print drawings created in Word G
[] Print background colors and images
[] Print document properties

[ Print hidden text

[ Update fields before printing

[ Update linked data before printing

-

OK I | Cancel

Proofing
Change how Word corrects and formats your text.

AutoCorrect options
Change how Word corrects and formats the text as you type [AutoCorrect options]

AutoCorrect options

1) AutoFormat

Apply (blue not selected, red selected)

Built-in Heading styles Automatic bulleted lists
List styles Other paragraph styles

Replace (blue not selected, red selected)
"Straight quotes™ with “smart quotes”

Ordinals (1st) with superscript

Fractions (1/2) with fraction character (%2)
Hyphens (--) with dash (-)

*Bold* and _italic_ with real formatting
Internet and network paths with hyperlinks

Preserve (blue not selected, red selected)



Styles

Always AutoFormat (blue not selected, red selected)
Plain text email documents

AutoCorrect Math AutoCorrect AutoFormat As You Type
AutoFormat Actions
Apply
[ ] Built-n Heading styles  [_] Automatic bulleted lists
[]List styles [ ] other paragraph styles
Replace

“Straight guotes™ with “smart quotes”™

[ ] ordinalz {1=t) with superscript

[ Fractions {1/2) with fraction character {3)
[ ] Hyphens (- with dash (—)

] *Bold* and _jtalic_ with real formatting

[ ] Internet and network paths with hyperlinks

Preserve
Styles

Always AutoFormat
[ ] Plain text e-mail documents

Conce

2) Actions
Word can provide additional actions, for certain words or phrases in your document, through the right-click menu.

Enable additional actions in the right-click menu

Available actions: (blue not selected, red selected)
Address (English)

Date (XML)

Financial Symbol (XML)

Instant Messaging Contacts (English)

Measurement Converter (Measurement Converter)

Person Name (English)

Place (English)

Telephone Number (XML)

Time (XML)



AutoCorrect Math AutoCorrect AutoFormat As You Type
AutoFormat Actions

Ward can provide additional actions, for certain words or phrases in your document,
through the right-click menu.

|:| Enable additional actions in the right-click menu
Available actions:

[Bddress {English]
Date (XML

Financial Symbol (XML}

Instant Messaging Contacts (English)

Measurement Converter (Measurement Converter)

Person Mame (English)

Flace [English)

Telephone Number (XML}

Time (XML)

[ o ] conce

3) AutoCorrect (none of these selected)
Show AutoCorrect Options buttons

Correct TWo INitial CApitals

Capitalize first letter of sentences

Capitalize first letter of table cells

Capitalize names of days

Correct accidental usage of cAPS LOCK key

Replace text as you type
[list]
Automatically use suggestions from the spelling checker



AutoFormat Actions
AutoCorrect Math AutoCorrect AutoFormat As You Type

[ ] show AutoCorrect Options buttons

(] Correct TWo Initial CApitals Exceptions...
[] Capitalize first letter of sentences

[ ] capitalize first letter of table cells

[] capitalize names of days

] Correct acddental usage of cAPS LOCK key

[ ] Replace text a2 you type
Replace: With: Flain text Formatted text

ele] Melete

Automatically use suggestions from the spelling chedker

4) Math AutoCorrect (none of these selected)

Use Math AutoCorrect rules outside of math regions
When Math AutoCorrect and AutoCorrect rules conflict, AutoCorrect rules will be used.
Replace text as you type [menu]

Recognized Functions [menu]
acos, acosh, acot, ... sup. tan, tanh.



AutoFormat Actions
AutoCorrect i Math AutoCorrect | AutcFormat As You Type

[[] Use Math AutoCorrect rules outside of math regions
When Math AutoCorrect and AutoCorrect rules conflict, AutoCorrect rules will
be used.

[ replace text as you type

Replace: With:

=

(N R

‘above
\acute
‘aleph
‘alpha
YAlpha
\amalg
\angle
\aoint
‘approx
‘asmash
‘ast

.

w = e e

Recognized Functions... Add

5) AutoFormat as you type

Replace as you type (blue not selected, red selected)

"Straight quotes” with “smart quotes” Ordinals (1st) with superscript
Fractions (1/2) with fraction character (¥2) Hyphens (--) with dash (-)
*Bold* and _italic_ with real formatting

Internet and network paths with hyperlinks

Apply as you type (hone of these selected)
Automatic bulleted lists Automatic numbered lists
Border lines Tables

Built-in Heading styles

Automatically as you type (none of these selected)
Format beginning of list item like the one before it

Set left- and first-indent with tabs and backspaces

Define styles based on your formatting



AutoFormat Actions
AutoCorrect Math AutoCorrect AutoFormat As You Type

Replace as you type
"Straight quotes” with "smart quotes” [] ordinals (1st) with superscript
[] Fractions (1/2) with fraction character {i2) [_] Hyphens {--) with dash (—)
[] *Bold= and _italic_ with real formatting
[J internet and network paths with hyperlinks

Apply as you type
[] automatic bulleted lists [] automatic numbered lists
[]Border lines [] Tables
[] Built-in Heading styles

Automatically as you type
[[] Format beginning of list item like the one before it
[] set left- and firstindent with tabs and backspaces
[] pefine styles based on your formatting

Carce

When correcting spelling in Microsoft Office programs
Ignore words in UPPERCASE

Ignore words that contain numbers

Ignore internet and file addresses

Flag repeated words

Enforce accented uppercase in French

Suggest from main dictionary only

Custom dictionaries [menu]

French modes [menu]

Spanish modes [menu]

When correcting spelling and grammar in Word

Check spelling as you type

Mark grammar errors as you type

Frequently confused words

Check grammar and refinements in the Editor pane

Show readability statistics

Choose the checks editor will perform for grammar and refinements setting
Writing style [menu]

Grammar

Academic degrees

Adjective used instead of adverb
Adverb instead of adjective
Agreement within noun phrases
‘An’ ‘and’ confusion
Capitalization

Capitalization of March and May
Capitalization of personal titles
Comma after greeting



Comma before quotations
Comma missing after introductory phrase
Comma splice

Comma with conjunctive adverbs
Comma with conjunction
Comma around descriptive clause
Commonly confused phrases
Commonly confused words
Comparative use

Correlative conjunction mismatch
Date formatting

Embarrassing words

Hyphenation

Incorrect auxiliary

Incorrect negation

Incorrect number ending
Incorrect pronoun case

Incorrect reflective pronoun use
Incorrect use of that

Incorrect verb form

Incorrect verb form after auxiliary
Indefinite article

Indirect questions

Misheard phrases

Missing comma

Modal confusion

Multiple modals

Noun number

Possessive and plural forms
Punctuation

Question mark missing
Redundant colon

Redundant comma before complement clause
Redundant question mark
Repeated auxiliary

Semicolon use

Spacing

Subject verb agreement

Too many determiners
Unnecessary hyphen

Use of plain verb form

Use of the word ‘lack’

Use of will and would

Verb use

Which who confusion

Who whom confusion

Word split

Clarity

Adverb placement

Double negation

Jargon

Passive voice

Passive voice with unknown actor
Sentence structure

Simpler wording

Split infinitives

Use of euphemisms



Conciseness

Conjunction overuse
Normalizations

Wordiness

Words expressing uncertainty

Formality

Colloquial verb phrase
Contractions

Informal language
Opinion markers
Slang

Subjunctive mood

Inclusiveness

Age bias

Cultural bias

Ethnic slurs

Gender bias

Gender specific language
Racial bias

Sexual orientation bias

Punctuation conventions

Comma with adverbials

Oxford comma

Unnecessary comma

Punctuation required with quotes [menu]
Space between sentences square [menu]

Resume

Avoid first person references
Superfluous expressions
Unsuitable expressions
Vague quantifiers

Vague verbs

Vocabulary

Clichés

Collective nouns
Locale-specific words
Region-specific words

Vague adjectives

Vague or unnecessary adverbs
Weak verbs

Check document
Exceptions for [menu]

Hide spelling errors in this document only
Hide grammar errors in this document only



Word Options ? X

G | =
EnerE E\lb/c Change how Word corrects and formats your text.

Displa

AutoCorrect options

Save Change how Word corrects and formats text as you type: | AutoCorrect Options...

Language

When correcting spelling in Microsoft Office programs
Ease of Access

[] Ignere words in UPPERCASE

O Ignore words that contain numpers

Advanced

Customize Ribben Ignore Internet and file addresses

Quick Access Toolbar O Flag repeated words
. . Enforce accented uppercase in French
Add-ins g = PP

[ Suggest from main dictionary only

Custom Dictionaries...

French modes: | Traditional and new spellings ~

Trust Center

Spanish modes: | Tuteo verb forms only 57

When correcting spelling and grammar in Word

[ Check spelling as you type

[] Mark grammar errors as you type

[ Check grammar and refinements in the Editor Pane
[ Show readability statistics

Choose the checks Editor will perform for Grammar and Refinements

Writing Style: | Grammar & Refinements =
Check Document

Exceptions for: @ Appendix 10_01 -

oK | | Cancel

Save
Customize how documents are saved.

Save documents

AutoSave OneDrive and SharePoint Online files by default on Word
Save files in this format: [menu]

Save AutoRecover information every [menu] minutes

Keep the last AutoRecovered version if | close without saving
AutoRecover file location: [menu]

Don’t show the Backstage when opening or saving files with keyboard shortcuts
Show additional places for saving, even if sign-in may be required.
Save to Computer by default

Default local file location: [menu]

Default personal templates location: [menu]

Offline editing options for document management server files

Saving checked out files to server drafts is no longer supported. Checked out files are now saved to the Office
Document Cache.

Server drafts location: [menu]

Preserve fidelity when sharing this document: [menu]

Embed fonts in the file

Embed only the characters used in the document (best for reducing file size)
Do not embed common system fonts



Word Options ? X

General [ ] .

Customize how documents are saved.
Display
Proofing Save documents

AutoSave OneDrive and SharePoint Online files by default on Word G

Language Save files in this format: Word Document (*.docx) -
Ease of Access Save AutoRecover information every | 20 % | minutes
[] Keep the last AutoRecovered version if | close without saving

AutoRecover file location: Ch\Users\Paul\AppData\Roaming\Microsoft\Word

[] Don't show the Backstage when opening or saving files with keyboard shortcuts

Advanced
Customize Ribbon
Quick Access Toolbar Show additional places for saving, even if sign-in may be required.

Add-ins Save to Computer by default

Trust Center Default local file location: CAVirtualAcorn\VirtualRPC-5A\HardDisc\MyFiles

Default personal templates location: |Ch\Users\Paul\AppData\Roaming\Microsoft\Templates

Offline editing options for document management server files

Saving checked out files to server drafts is no longer supported. Checked out files are now saved to the
Office Document Cache.

Learn more

Server drafts location: |C\Users\Paul\Documents\SharePoint Drafts\

Preserve fidelity when sharing this document: @ Appendix 10_01 hd

[] Embed fonts in the file G

oK | | Cancel

Language
Set the Office Language Preferences

Office display language

Buttons, menus, and other controls will show in the first available language on this list.
1. Match Microsoft Windows <preferred>

2. English

Install additional display languages from Office.com

Office authoring languages and proofing

Manage languages used for creating and editing documents, including proofing tools such as spelling and grammar
check.

English (United Kingdom) <preferred> Proofing installed

Install additional keyboards from Windows Settings



Word Options ? x

General .

e }D?f Set the Office Language Preferences
Display
Proofing Office display language

Buttons, menus, and other contrels will show in the first available language on this list.G
1. Match Microsoft Windows [English] <preferred>
2. English

Ease of Access

Move Down

Advanced

Customize Ribbon
Install additional display languages from Office.com

Cluick Access Toolbar

Add-ins Office authoring languages and proofing

Trust Center . . . . )
Manage languages used for creating and editing documents, including proofing tools such

as spelling and grammar check.

English (United Kingdom) <preferred= Proofing installed
Add a Language...

Install additional keyboards from Windows Settings

Cancel

Ease of access
Make Word more accessible.

Make your document accessible to others

The accessability checker helps you find and fix content in your document that may make it harder for people with
disabilities to consume your content. You can get it from Review > Check Access ability. Office can remind you
about accessibility issues while you work by showing a reminder in the Status Bar.

Keep accessability checkout running while | work

Feedback options

Provide feedback with sound
Sound Scheme: [menu]

Provide feedback with animation

Application display options

ScreenTip style [menu]
Show feature descriptions in ScreenTips
Don't show feature descriptions in ScreenTips
Don't show ScreenTips

Show shortcut keys in ScreenTips

Show the start screen when this application starts

Automatic Alt Text
Automatic alt text generates descriptions for pictures to make them accessible for people with vision impairments.
Access alt text at any time by clicking “Edit alt text...” in the context menu for pictures.

Automatically generate alt text for me.

Document display options
Expand all headings when opening a document



Word Options ?

General .
Di Make Word more accessible.
Display -
Proofing Make your document accessible to others
Save The accessibility checker helps you find and fix content in your document that may make it harder for people with
disabilities to consume your content, You can get to it from Review > Check Accessibility. Office can remind you about
Language accessibility issues while you work by showing a reminder in the Status Bar.

] Ease of Access [ Keep accessibility checker running while | work

Advanced Feedback options

Customize Ribben [1 Provide feedback with sound

Quick Access Toolbar Sound Scheme: A

Add-ins [ Provide feedback with animation
Trust Center Application display options

ScreenTip style: | Show feature descriptions in ScreenTips =
Show shortcut keys in ScreenTips
[ Show the Start screen when this application starts

Automatic Alt Text
Automatic alt text generates descriptions for pictures to make them accessible for people with vision impairments.
Access alt text at any time by clicking "Edit alt text...” in the context menu for pictures,
Automatically generate alt text for me

Document display options

[ Expand all headings when opening a document ©

Advanced
Advanced options for working with Word

Editing options

Typing replaces selected text

When selecting, automatically select entire word

Allow text to be dragged and dropped

Use CTRL + Click to follow hyperlink

Automatically create drawing canvas when inserting AutoShapes

Use smart paragraph selection
Use smart cursoring

Use the Insert key to control overtype mode
Use overtype mode
Prompt to update style
Use Normal style for bulleted or numbered lists
Keep track of formatting
Mark formatting inconsistencies
Updating style to match selection: [menu]
Enable click and type
Default paragraph style: [menu]
Show AutoComplete suggestions
Do not automatically hyperlink screenshot

Cut, copy, and paste (none of these selected)

Pasting within the same documents: [menu]

Pasting between documents: [menu]

Pasting between documents when style definitions conflict: [menu]
Pasting from other programs: [menu]

Insert/paste pictures as: [menu]

Keep bullets and numbers when pasting text with Keep Text Only option
Use the Insert key for paste

<— My advice: switch this off!

<— My advice: switch this off!
<— My advice: switch this off!



Show Paste Options button when content is pasted

Use smart cut and paste
Use default options for [menu]
Individual options
Adjust sentence and word spacing automatically
Adjust paragraph spacing on paste
Adjust table formatting and alignment on paste
Smart style behaviour

Merge formatting when pasting from Microsoft PowerPoint
Adjust formatting when pasting from Microsoft Excel

Merge pasted lists with surrounding lists

Link handling
Open supported hyperlinks to Office files in Office desktop apps

Pen
Used pen to select and interact with content by default

Image size and quality
Discard editing data

Do not compress images in file
Default resolution: [menu]

Chart
Properties follow chart data point

Show document content
Show background colors and images in Print Layout view
Show text wrapped within the document window
Show picture placeholders
Show drawings and text boxes on screen
Show bookmarks
Show text boundaries
Show crop marks
Show field codes instead of their values
Field shading: [menu]
Use draft font in Draft and Outline views
Name: [menu]
Size: [menu]
Font substitution
Expand all headings when opening a document

Display

Show this number of recent documents [menu]

Quickly access the number of recent documents

Show this number of unpinned recent folders

Show measurements in units of [menu]

Style area pane width in Draft and Outline views [menu]
Show pixels for HTML features

Show shortcut keys in ScreenTips

Show horizontal scroll bar

Show vertical scroll bar

Show vertical ruler in Print Layout view

Optimize character positioning for layout rather than readability
Disable hardware graphics acceleration

Update document content while dragging

Use subpixel positioning to smooth fonts on screen

Show pop-up buttons for adding rows and columns in tables

<— My advice: switch this off!



Print

Use draft quality

Print in background

Print pages in reverse order

Print XML tags

Print field codes instead of their values
Allow fields containing track changes to update before printing
Print on front of the sheet for duplex printing
Print on back of the sheet for duplex printing
Scale contents for A4 or 8.5 x 11" paper sizes
Default tray: [menu]

When printing this document
Print PostScript over text
Print only the data from a form

Save

Prompt before saving Normal template

Always create backup copy

Copy remotely stored files onto your computer, and update the remote file when saving
Allow background saves

Preserve fidelity when sharing this document [menu]
Save form data as delimited text file
Embed linguistic data

General

Confirm file format conversion on open

Update automatic links at open

Allow opening a document in Draft view

Enable background repagination

Show add-in user interface errors

Mailing address: [input box]

File locations: [menu]

Web options: [menu] (Too many to type out, sorry!)

Compatibility options for: [menu]
Lay out this document as if created in: [menu]



General & . " i

EE Advanced options for working with Word.
Display
Proofing Editing options
Save [ Typing replaces selected text

|:| When selecting, automatically select entire word
Language

|2| Allow text to be dragged and dropped
Advanced [ use CTRL = Click to follow hyperlink
|:] Automatically create drawing canvas when inserting AutoShapes

Customize Ribbon
|:| Use smart paragraph selection

Quick Access Toolbar |:| Use smart cursoring

IZ] Use the Insert key to control overtype mode
[] use overtype mode

Trust Center ] prompt to update style

|:| Use Normal style for bulleted or numbered lists

I:I Keep track of formatting

Add-Ins

Mark formatting inconsistencies

Updating style to match selection: | Keep previous numbering and bullets pattern
[ Enable click and type
Default paragraph style: i Normal

|:| Show AutoComplete suggestions

Cut, copy. and paste
Pasting within the same document: , Keep Source Formatting (Default) E]
Pasting between documents: I Keep Source Formatting (Default) E]
Pasting between documents when style definitions conflict: IKeep Source Formatting
Pasting from other programs: [Keep Source Formatting (Default) E]
Insert/paste pictures as: [In line with text

|Z Keep bullets and numbers when pasting text with Keep Text Only option
[:l Use the Insert key for paste
l:] Show Paste Options button when content is pasted

[J use smart cut and paste (i) ' Settings...

Image Size and Quality ‘["-,i__b] Options in Word 2010 El

[] piscard editing data

[] po not compress images in file
A

Set default target output to: !220 ppi

Show document content

|Z Show background colors and images in Print Layout view
l:| Show text wrapped within the document window

|:] Show picture placeholders i

IZI Show drawings and text boxes on screen

[ show text animation

[] show bookmarks

[ show text boundaries




General D Show crop marks
|:] Show field codes instead of their values

Display o TR e
Field shading: lWhen selected v l

Proofing |:] Use draft font in Draft and Outline views
Save Name: ICourier New | &
: e
Language Size: |10 :]
e ] | Font Substitution...
Customize Ribbon Display
Quick Access Toolbar ; . l (el
Show this number of Recent Documents: '725 Eﬂ (i
Add-Ins Show measurements in units of: ‘\ Centimeters E

Style area pane width in Draft and Outline views: FO cm [
[ show pixels for HTML features

[] show all windows in the Taskbar

Show shortcut keys in ScreenTips

M show horizontal scroll bar

Show vertical scroll bar

Show vertical ruler in Print Layout view

D Optimize character positioning for layout rather than readability
|:] Disable hardware graphics acceleration

Trust Center

Print

[] use draft quality

Print in background (i

[] Pprint pages in reverse order

[] Print XML tags

[ print field codes instead of their values

E] Allow fields containing tracked changes to update before printing
|:| Print on front of the sheet for duplex printing

|:] Print on back of the sheet for duplex printing

IZ Scale content for A4 or 8.5 x 11" paper sizes

Default tray: yje printer settings JZ]

When printing this document: }@] Options in Word 2010 | v I

E] Print PostScript over text
|:] Print only the data from a form

Save

D Prompt before saving Normal template i

|:| Always create backup copy

D Copy remotely stored files onto your computer, and update the remote file when saving
[ Allow background saves

Preserve fidelity when sharing this document: 1@ Options in Word 201 OE

|:| Save form data as delimited text file
Embed linguistic data




General

Provide feedback with sound

Provide feedback with animation
Confirm file format conversion on open
Update automatic links at open

Allow opening a document in Draft view
Enable background repagination

Show add-in user interface errors

KOS OROOO

Show customer submitted Office.com content
Mailing address: |

File Locations... Web Options...

Compatibility options for: | #] Options in Word 2010 | v |

Lay out this document as if created in: | Microsoft Office Word 2003 |+ |
|> Layout Options

Trust Center
Help keep your documents safe and your computer secure and healthy.

Security & more
Visit Office.com to learn more about protecting your privacy and security.
Microsoft Trust Center

Microsoft Word Trust Center

The Trust Center contains security and privacy settings. These settings help keep your computer secure. We
recommend that you do not change these settings.

(In which case, there’s no point in my typing them out for you!)

Trust Centre Settings [menu]

Word Options ? x

G |
enera @ Help keep your documents safe and your computer secure and healthy.

Display

Proofing Security & more

Save Visit Office.com to learn more about protecting your privacy and security.
Language Microsoft Trust Center

Ease of Access
Microsoft Word Trust Center
Advanced
The Trust Center contains security and privacy settings. These settings

Customize Ribbon help keep your computer secure. We recommend that you do not change | Tyust Center Settings...

these settings.
Quick Access Toolbar
Add-ins

Trust Center




Macro Settings

Disable all macros without notification <— My advice: Leave this as the selected item. It refers to incoming
macros. To run your own macros (or mine!) on your
computer you don’t need to change this setting.

Disable all macros with notification

Disable all macros except digitally signed macros

Enable all macros (not recommended; potentially dangerous code can run)

Developer Macro Settings
Trust access to the VBA project object model

Trusted Publishers

Macro Settings

Trusted Locations
® Dizable all macros without notification

Trusted Decuments o ) o
I Disable all macros with notification

Trusted Add-in Catalogs ) Disable all macros except digitally signed macros

Add-ins ) Enable all macros (not recommended: potentially dangerous code can run)
ActiveX Settings Developer Macro Settings
Macro Settings

(] Trust access to the VBA project ohject model
Protected View

Message Bar
File Block Settings

Privacy Options

0K I | Cancel

Removing personal information

N.B. First save a copy of your file, in case you want to revert to it!

Click the File tab, and then click Info.

Click the third box “Check for Issues”, where it also says “Inspect Document”.
Select the Inspect Document option.

In the Document Inspector dialog box, click Inspect.

If there is personal information, an exclamation mark will indicate the fact.

DON’T click to remove Comments, Revisions, and Versions (you want to keep the comments, presumably) but DO
click on Document Properties and Personal Information.

All the comments should now just say “Author”.



